Foreword
I have used Toad™ for 10 years, since I made the leap from Access® to Oracle®. Most of my time is spent in the editor, writing new code or opening and running one of the many snippets I have saved there over the years. Toad makes me more efficient, the latest version reminds me of errors before I even hit compile. Using code review, there is an instructor standing over my shoulder every time I hit format.

I work in a small IT group and wear many hats. Everything I need to do in Oracle, I do in Toad. From simple data or whole schema imports, exports, and comparisons to building out completely new projects it’s a click or two away. And even while Toad has made me more efficient and my job easier to do right, it is the community around it that makes it more than just software. From forums and mailing lists to blogs, users from all over enjoy sharing and discussing all that it can do. I’m sure there are some tips in here that I will be trying out real soon.

– Jim Graham, Database Developer

Introduction
Toad™ for Oracle® has been the IT community’s tool of choice for more than a decade. With Toad, you are a member of an elite community of two million plus Oracle professionals.

Whether you are new to Toad or have been using it for several years, there are several features that you should be familiar with for achieving maximum productivity. This document will step you through some Toad fundamentals and break down the features for the following Toad editions and modules:

• Toad for Oracle Base Edition
• Toad for Oracle Professional Edition
• Toad for Oracle Xpert Edition, which includes our proprietary SQL and index-optimization technology
• Toad for Oracle DB Admin Module, which helps DBAs or development teams manage their Oracle environments
Most tools offer a single display model for objects in the database. Toad offers three!

If you are already a Toad customer and do not have access to the features discussed below, please contact your Dell™ Software sales representative and request an evaluation key.

**Toad for Oracle Base Edition**

Regardless of your responsibility in your organization, if you work with Oracle, then you will need a quick and efficient way to access the data in your database. This section of the document will step you through how to browse the contents of tables, write your own custom queries, and view the relationships of your database objects.

This section also discusses the powerful features of Toad that help you develop and maintain PL/SQL stored procedures. Toad users generally spend most of their time in two areas: the Schema Browser and the Editor.

**Schema browser**

The Schema Browser is your gateway to the database objects in your Oracle instance. Simply select the user/schema, database object type, and database object on your left, then immediately gain access to all the pertinent information for that object on your right.

**Customizing the display**

Most tools offer a single display model for objects in the database. Toad offers three! Toad can display your objects in a tree view, a dropdown selector, or a tab/page panel.

**Toad tip:** Selecting “Dropdown” will give you the most real estate for listing objects and allow you to use the keyboard to navigate the object type list. Selecting “Treeview” will make Toad look and feel more like SQL Navigator or Oracle® SQL Developer.

![Toad’s tree view](image-url)
The Schema Browser allows you to create groups of schemas for each connected database.

**Basic navigation**
Find your object on the left side. Select it and the meta-data or details for the selected object will appear on the right side. As you click around the database, Toad builds a historical list.

Quickly navigate to objects that you’ve browsed to previously using the “Back” and “Forward” buttons on the right-side toolbar.

**Filtering**
By default, Toad will display all objects in the database that you have access to. If you are working in a system with many thousands of objects, this can quickly become overwhelming and hurt your productivity. Therefore, Toad offers several levels of filters.

**Hiding Schemas/Users**
The Schema Browser allows you to create groups of schemas for each connected database. For example, you could create a group called “Oracle Test Data” that contained the “SCOTT,” “HR” and “SH” accounts. You can create custom groups to manage your production and test accounts or your different application schemas. Schemas you access on a limited basis would be “hidden” under the “Other Schemas” category.

To get started, right-click on the schema selector (or a schema node in the treeview) and select “Customize.” This will open the Customize Schema Dropdowns dialog. From here you can assign schemas to as many groups as you like.
If you are working on a project that will require frequent access to specific list of objects across object types and schemas, then you may benefit from the “Favorites” panel in the Schema Browser.

Toad tip: Tell Toad to load only schemas that own objects: right-click on the schema selector or set in the View > Toad Options dialog on the Schema Browser page.

Filtering object lists
Each object type has an independently defined filter. By default Toad will show all objects for the selected type.

- Quick filter – A basic pattern matching input box. You can input “C*; D*” for example and have only objects that start with the letter “C” or “D.” This control does not support regular expressions. In Toad for Oracle v10.5 and higher, the filtering clause is applied ONLY to the selected object list. So if you define a filter while the “Tables” object list is active, the filter will not apply to “Views.”

- Project filters – See below.
- Filter dialog – A much more powerful control.

Data grid filters
You can also filter the data displayed in any data grid, not just ones found in the Schema Browser, as explained in the “Data Grids” section below.

Organizing objects
If you are working on a project that will require frequent access to specific list of objects across object types and schemas, then you may benefit from the “Favorites” panel in the Schema Browser.

Figure 3. Use the Customize Schema Drop downs dialog to assign schemas to groups (applies to the Object Palette).

Figure 4. You can load only schemas that own objects by right-clicking on the schema selector or set.
Projects
If you want to extend the favorites concept beyond database objects, then I recommend checking out the Project Manager. To add database objects to a project, right-click one or more objects and select “Add to Project Manager.” You can also drag and drop the Objects from Schema Browser into the Project Manager panel.

Having a project defined also allows you to filter your object lists in the Schema Browser by project. This can be handy when you are logged into a 30,000+ object schema that contains tables for 30 different applications and you want to see only the “Payroll” tables, not everything.

Are you feeling overwhelmed by the Toad Interface? Read this blog on de-cluttering your Toad desktop.
By default, Toad displays all of the detail information for your objects on the right side. You can manually add any of these detail items to the left side by right-clicking in the column header on the left side. For example, you could add “Num Rows” for Tables and sort by table size stats for an estimated number of rows.

Right-click functions
Many powerful features of Toad are exposed by using your mouse. Right clicking on a table in the Schema Browser will expose more than 35 different operations. If you rely on having a button available on the screen, you may be missing out.

Overwhelmed by the Toad interface? Read this blog post on how to simplify Toad.

Toad tips:
1. Multi-select objects and then right-click.
2. Where you right-click determines what you see: grids, toolbars, menus, grid headers, etc.

Figure 7. Additional details available in the right-click menu
Figure 8. Schema Browser’s right-click menu
Figure 9. Editor button on toolbar
Editor
Toad now has a single editor for working with SQL and PL/SQL objects. Older versions of Toad had separate editors, but the former SQL Editor, PL/SQL Editor, and offline editors have been condensed to a single window for all of your editing related to SQL, PL/SQL, anonymous block, SQL*Plus script, etc., as well as for ad hoc querying on the database.

The editor is for building and executing your Oracle commands. Anything you can execute via SQL*Plus can also be executed via the Toad Editor. This includes:
- Anonymous blocks
- SQL, DDL & DML
- PL/SQL
- RMAN commands
- Stored Java procedures
- SQL*Plus scripts

Writing code from scratch
An empty editor might seem like more of a “blank screen of panic” for those less comfortable with Oracle’s syntactical rules and commands. Toad has many of these commands built-in and available to invoke on demand.

Code templates
Code templates are commonly written PL/SQL blocks of code that you can have generated on demand. As an example, try typing the following into a blank editor:

`anon <Ctrl>Spacebar`

This will activate the anonymous block code template:

Each template has a name, description, and code component. To activate a template, type its name followed by the <Ctrl>Spacebar key sequence. If no text is at the current cursor position, then a pop-up list of all the templates will appear for you to select from.

Figure 10. Code templates list box
The default templates can be modified by right-clicking in the Editor and choosing “Editing Options.” From there you will default into the behavior portion of the Editor options. Click the “Code Templates” button. Templates can be extended, modified, removed, and even shared with other Toad users.

**Toad tip:** Make your templates dynamic by using the & character.

**Code insight**
Toad can help you write your SQL and/or PL/SQL statements. As you type, Toad can offer to complete the command or object name for you. The Code Insight feature has been remarkably improved over the past several releases. As you may remember from older versions, Code Insight (<ctrl>+<Period> from the editor) allows you to quickly browse and select tables in the editor. Code Insight has the ability to see the following object types:
- Tables
- Views
- Aliases
- Functions, procedures and packages (with methods)
- Types (with attributes and methods)
- Java source
- Sequences
- Users
- Expected tokens (keywords)
- Available variables and parameters
- Collection types
- Public and private synonyms

**Toad tips:**
1. You can disable this feature in part or in full.
2. You can disable support for expected tokens.
For example, suppose I want to query from a schema that starts with “Matthew.” Toad will recognize that text and pop up a complete list of accounts that match that string:

For performance reasons, not all object types are enabled by default; in particular, public synonyms are not. So if you are looking for help referencing a DBMS_ package, you will need to preface it with the “SYS” notation or enable the public synonym support.

All of the Code Insight options can be found on the Editor’s Code Assist page in the Options dialog. To disable code insight, uncheck the “Enable Code Insight pick list” option. You can still invoke the code assistance feature on demand by using the “CTRL”+ “Period” key sequence.

A less drastic approach would be to increase the timer delay to something like 5000. This would give you a good five seconds before Toad attempts to auto-complete your text.

**F4/DESC**

If you have ever used SQL*Plus, you are probably familiar with the DESC command, which gives you a table or view definition. Toad has its own DESC command that will work on any object in the database.

To use the Toad DESC, simply put your cursor on an object name you have typed in the editor and use the F4 key. This will open a pop-up dialog that gives you all of the same information you would see in the Schema Browser.

**Toad tips:**
1. You can DESC as many objects as you want.
2. You can drag column names into the editor.
3. You can modify the object from the DESC.

**Recall previous SQL**

Every valid SQL statement you execute via F9 is automatically recorded by Toad. You can access previously executed SQL by using F8. The same panel is available under the View menu. By default, Toad stores the last 500 executed statements.

**Toad tip:**

You can cycle through your list of previously written SQL statements using <ALT>+<Up Arrow> or <ALT>+<Down Arrow>. You can do this on selected text to do a limited replacement.

---

Figure 13. Using the Toad DESC command
Giving your SQL statements a name allows you to recall your query by context versus some obscure SQL you may have written six months ago. Some general advice: if you spend more than 30 seconds writing a SQL statement, give it a name. You can now recall it without using the F8 dialog, giving you more room to type in the editor. Use <CNTRL>+N to pop up a list of named SQL statements. Selecting one will put the SQL in your editor.

Split editor
If you are working on an extremely large block of code and want to view or edit multiple sections simultaneously, right-click in the editor panel and choose “Split Editor Layout.” You can use either a “Top/Bottom” or a “Left/Right” theme.

Make code statements
Toad supports six different programming languages (C++, Delphi, Perl, and more), which can be selected from the Options menu. From there you can create code statements based on SQL, or strip non-SQL syntax from a code statement. For example, to take a SQL statement and automatically format it to be embedded into a Java program, you can simply select “Make CODE Statement” from the Editor menu. This will copy the current window’s statement to the clipboard in the language syntax you select. The next step is to paste the formatted SQL call into the code. You can extend this feature to the programming language of your choice by adding it manually in the Options dialog.

Looking for help on how to execute statements and scripts? Read this blog.

Format code
To instantly transform chaotic, untidy code into easily managed, aesthetically pleasing code, right-click in the editor and select the icon with two yellow arrows, as shown below. Under the View menu option, select “Formatting Options” to customize the code formatting.
Working with PL/SQL

Toad is a full featured IDE that allows a PL/SQL developer to accomplish the following quickly and easily:

• Create PL/SQL stored procedures
• Execute said procedures
• Identify syntax errors
• Debug PL/SQL objects
• Perform automated code reviews
• Document the PL/SQL objects
• Identify execution bottlenecks
• Load test the PL/SQL objects
• Unit test the PL/SQL objects
• Capture REFCURSOR output
• Refactor PL/SQL
• Control PL/SQL via source control

To cover these topics in detail here would make this paper many pages longer and likely try your patience. Instead, we will cover a few of my favorite and most-frequently overlooked features. You can learn more about the other features on Toad World.

Execution profiling

Toad allows you to profile your PL/SQL executions to determine where any execution bottlenecks are occurring and answer the question, “Why is my program taking so long to run?” To start a profiler run, toggle “on” the “stopwatch” button next to the “debug” toggle. Then execute your PL/SQL program from the Editor. After it is finished, pull up the record from the Profiler tab. With Toad for Oracle v9.6 and higher, you can automatically pull up the visual chart representations of your PL/SQL runs by clicking on the Details button.

Toad allows you to profile your PL/SQL executions to determine where any execution bottlenecks are occurring and answer the question, “Why is my program taking so long to run?”

Figure 16. Quickly determine which line of code is taking the most time to run.

Figure 17. Toggle on the Details view to see a graphical representation.
The debugger can be your best friend to figure out why your program isn’t behaving as expected. It runs your program line by line, stepping through the code.

If you are on Oracle 11g or higher, then Toad also supports Oracle’s hierarchical profiler.

Debugger
The debugger can be your best friend to figure out why your program isn’t behaving as expected. It runs your program line by line, stepping through the code.

- **Setting breakpoints:** To set execution breaks in the code, leave the cursor on the line on which you want the code to break and hit F5. Set conditional breaks by double clicking the break in the Break and Watch View window. Make sure to only add breakpoints that are executable; these are marked by little blue dots in the editor gutter for each line. Non-executable lines will not have their breakpoints honored by Oracle.

- **Adding a watch:** To add a watch on a variable, leave the cursor blinking on the variable on which the watch is desired and click the eyeglasses icon. Toad allows you to see the values of all your code variables by using the “Enable Smart Watches” feature.

- **Modifying variable values while debugging:** To artificially change the value of one of your PL/SQL variables, highlight the variable in the watch window and hit the calculator on the icon bar which, once moused over, will read “Evaluate/Modify Watch.”
Running SQL inside of PL/SQL
While most of you know that you use F9 to execute a single SQL statement, did you know you can use <CTRL>+<ENTER> on embedded SQL in your PL/SQL code? Toad will extract the SQL and attempt to execute it. Any variables will need to be assigned, but Toad will ask you for required values.

Looking for an alternative to debugging? Read this blog on how to get Toad to generate your DBMS_OUTPUT scenarios automatically (new in Toad for Oracle v10.5).

Data grids
You may be asking why I took so long to get to the most important feature. The data grids are integrated into multiple Toad windows. So while it is tied to both the Editor and the Schema Browser, it is not a stand-alone feature. The following are a few tips and tricks for getting more out of the data grids.

Sorting/filtering
Toad makes it easy to apply a sort or filter on your data via the grid. Note that this feature is not available for grids in the Editor.

If you want to apply multiple sort conditions, then use the Sort panel to assign a condition for each field. You can also decide how NULLs should be treated.

Filtering is available in several different mechanisms.

Toad tip: The easiest way to apply a filter is to click into a cell that has the value you want filtered on, click on the filter control, and choose ‘Add to filter... current value.’
Figure 22. Applying a filter (the variable value is defined by the active cell)

Figure 23. Filter condition copied to dialog
A few notes about the filter dialog:
- Filters can be named for easy recall.
- The WHERE clause can be input manually.
- You can use conditions, such as BETWEEN and NOT IN.
- Filters are remembered between sessions. If the funnel control is colored RED, then the filter is active.

**Column management**

You can easily disable a column in a grid by using the column selector at the top left corner of each grid. Columns can also be re-ordered by dragging the column header with your mouse to the desired location in the grid.

With Toad, you can now disable a column simply by dragging it away from its current location until you see an “X” symbol and then releasing the mouse button.

Each change will be reflected when data is copied or exported out of the grid. You can restore the grid to its original state with the right-click “Reset columns” command.
Toad tip: Fix a column. After a column is fixed, as you scroll left and right in a grid that column remains fixed. You may fix as many columns as you like.

Toad lets you apply grouping at the column level. You will need to activate the Group panel via right-click. Then simply drag a column to the panel space to apply a group condition. You can have multiple levels of grouping.

Toad has a Single Record view that allows you to view records one at a time vertically. Click the “open book” button to start using this feature.
You can now apply a visual color style to the data grids in Toad.

Grid styles
You can now apply a visual color style to the data grids in Toad. This can lessen eye strain when having to stare at millions of rows of data all day long. To apply a style, open the options and go to the Data Grids, Visual page.
Calculated fields
Toad can count, sum, average, min, and max selected numerical values in a grid. You can simply select the cells you want to perform the calculation on, and then hit the new “Sigma” button on the data grid tool bar.

Toad tips:
1. You can select values across multiple columns. Once calculated, you can copy and paste the data from the bottom panel.
2. The Schema Browser has a new “Show Detail Dataset” button. This allows you to see children records for the selected row.

Reporting
To access the Toad reporting interface, right-click in the Data Grid and select “Report.” You will find a report generation wizard to walk you through report creation. Expert Gary Piper has a lot of great material on doing more with Toad reports on Toad World.

Handy utilities
ER diagram
To generate an entity relationship diagram (ERD), select the objects you want diagrammed in the Schema Browser and right-click -> “ER Diagram.”
You can easily export the visual diagram to a full rendered HTML version, with which anyone can interact, even outside of Toad. If you need to alter models and push migration DDL scripts or compare models, you will need to use Toad™ Data Modeler, which is free to use for all licensed Toad for Oracle users who are also current on maintenance. The diagrams are generated by reading the foreign key constraints defined in the database.

Toad tip: If you have a database that does not use foreign keys, you can use Toad Data Modeler to reverse engineer a schema and use the “Infer Relationships” feature to guess relationships based on common column names between tables.

Any ERD may be exported to a what-you-see-is-what-you-get HTML report.

**Code Road Map**

The Code Road Map is similar to an ER Diagram, but from the stored procedure (PL/SQL) perspective. The Code Road Map parses an object’s source code and identifies the other Oracle objects on which it is dependent. If a view calls from six different tables, Toad can diagram that. Or, if your PL/SQL function makes a package call that is dependent on a table and sequence, then Toad will diagram that. Choose your trigger, procedure, function, or package in the Schema Browser and right-click “Code Road Map.”

The Code Road Map parses an object’s source code and identifies the other Oracle objects on which it is dependent. If a view calls from six different tables, Toad can diagram that.
The reporting for the Code Road Map is identical to ER diagrams. You can also use the “Create Script” button to generate a DDL script to build a test or development sandbox environment where everything to compile and execute your PL/SQL is present, saving you the need to copy an entire Schema to test a single object.

Toad tip: You can also use the Code Road Map to build a diagram for your views.

Query builder (formerly SQL Modeler)
Query Builder allows for building queries visually. Did you know that this was the most frequently cited Toad feature for saving time in a recent user survey? That’s right: people said this window saved them more time than any other feature in Toad.

The next time you need to query from more than two or three tables, try the Query Builder. Who wants to type out all the SELECT, FROM, and JOIN clauses?

The next time you need to query from more than two or three tables, try the Query Builder. Who wants to type out all the SELECT, FROM, and JOIN clauses?

A few key features:
- **Select tables**: Using the Object Palette (opened automatically), select one or tables or views necessary for your query and drag them into the workspace.
- **View joins**: If the tables have relationships defined by referential integrity constraints (foreign keys), Toad will automatically detect these and join your tables/views. Double click on a link to view or change the Join condition for your query.
- **Choose columns**: Double-click in the check boxes of the columns desired for your query.
- **Add where clause criteria**: Drag a selected column from the “SELECT” tree area and drop it on the “WHERE” area. You can also right-click on a column in the tree and select “Include in Where Clause.” This will open the “Where Definition” window. Click on the ellipsis button to see distinct values for the selected field to help you build a meaningful where condition.

Figure 35. Viewing joins in Query Builder
• View generated query: View the SQL by looking at bottom of the screen.
• Run generated query: Run the query with the F9 key or the green play button to return a data set.
• Explain plan: View the explain plan by clicking on the ambulance icon on the second of the top two icon bars.
• Create a model from existing query: From the Editor, right-click and select “Send to Query Builder” to reverse-engineer your selected query to a Query Builder model.

Toad tip: Toad can write your joins using ANSI join syntax. This is ideal for applications supporting both Oracle and SQL Server environments.

Jump search (new in v12.0)
This new and enhanced search utility may become the most commonly used feature. It helps you search through all the Toad windows, menus, and options. Sometimes, you just want to quickly navigate to the appropriate user interface in Toad, and you may find this utility very helpful in guiding you within the product.

Querying databases other than Oracle
Introducing Toad™ Data Point
If you like the Toad for Oracle interface, you will be pleased to know that a similar Toad product is available for other databases.

Figure 36. Sample Data dialogue in the Query Builder where definition feature

Figure 37. Data Compare across platforms in Toad™ Data Point
With Toad Data Point, you can:

• Connect natively to the following non-Oracle databases:
  • IBM® DB2 LUW or z/OS
  • Microsoft® SQL Server®
  • MySQL®
  • Sybase® ASE, SQL Anywhere or IQ
• Connect via ODBC to other databases, including:
  • Teradata®
  • Informix®
  • PostreSQL®
  • Any datasource that supports the ODBC v3 protocol
• Quickly connect to Microsoft® Access® and Microsoft® Excel® without ODBC configuration for querying, reporting, and exports/imports
• Build queries visually or use the familiar Toad editor to get to your data
• Browse the contents of the database using a single browser (just like Toad for Oracle)
• Compare and synch data between different databases
• With rich Microsoft Excel integration, build pivot tables and ODBC linked queries on the fly

Notes regarding this feature:

• Toad Data Point is available for free for Toad for Oracle Suites (DEV and DBA) users.
• If you need to perform database administration or application development tasks, then be aware we have a Toad IDE specifically built for those platforms (e.g., Toad™ for MySQL, Toad™ for IBM® DB2, Toad™ for SQL Server®).
• Toad for Oracle remains your ‘go-to’ tool for anything Oracle. Toad Data Point is provided here to give you access to the data in sources other than Oracle.

Base edition summary

As you can see, the Base Edition of Toad is packed full of features. And to be honest, we barely covered 10 percent of them. As you know, Toad is available in multiple editions. The rest of this document discusses premium features available with the Professional, Xpert, and DB Admin Module upgrades.
Toad for Oracle Professional Edition
Automatically generate test data
Need more and better-looking test data to drive your applications? Generate test data for one or more tables automatically. Toad can do that in a couple of clicks.

Toad tip: Toad for Oracle Professional edition allows you to select one or more tables and generate test data. Toad will even honor your foreign key relationships when creating key values. Toad can generate real-looking product data.

Code analysis
Also included with the Professional Edition is Code Analysis, our revolutionary SQL and PL/SQL automated code review and documentation system. Learn more about Code Analysis.

Don’t let code reviews become an expensive and sensitive situation for your development teams. Toad is the only PL/SQL IDE that offers best practices programming advice for your Oracle developers.
The Toad Development Suite for Oracle introduces a full load and functional testing suite for your PL/SQL code. You can generate functional tests for your PL/SQL without writing any PL/SQL.

Load and functional testing suite for PL/SQL code
The Toad™ Development Suite for Oracle® introduces a full load and functional testing suite for your PL/SQL code. You can generate functional tests for your PL/SQL without writing any PL/SQL.

Toad tip: The run to test function lets you run your PL/SQL program and have Toad record the observable behavior as your unit test. Regression testing is only a click away.

Test performance
You are only a right-click away from load testing your stored procedures in Toad as well. Put your code to the test by spinning up a hundred concurrent sessions. Find out when your performance service level agreements fall apart.

Figure 41. Describe in plain English the behavior of your PL/SQL program, and let Toad generate and manage your test code. Run a regression test any time you make a change to your program – Integration with Code Tester

Figure 42. Integration with Benchmark Factory for Databases
Toad for Oracle Xpert Edition

Toad for Oracle Xpert Edition includes a comprehensive SQL optimization solution that will identify problematic SQL, tune statements automatically, suggest index alternatives, and even provide impact analysis when implementing changes that could hurt database performance. Wherever you encounter SQL in Toad, you can also invoke a tuning session for that statement by simply clicking the “Optimize SQL” button.

Tuning current statement from the editor

When you find a problematic SQL statement in the Toad Editor, it is very easy to move the statement into our tuning lab. Just select the SQL you want to tune, and click the “Advanced SQL Optimization” button. Click the down arrow at the side of the button with the yellow beaker with the tuning fork (found on the right of the printer button).

You will then be prompted to send the SQL code to the Optimize SQL or the Batch Optimize screens. I recommend you become comfortable with the Optimize SQL, which allows you to manually tune a query, before you use the automatic Batch Optimize technology.

Toad tip: When using the stand-alone SQL Optimizer, right-click on the toolbar and select “Show Captions.”

Optimize SQL

The Optimize SQL window guides you from analyzing the current execution plan to automatically generating SQL query rewrites that will identify better-performing queries. Toad can generate and evaluate the theoretical execution plan.

You can view the plan in several different formats and even get detailed documentation for each plan step—all by right-clicking your mouse.

Figure 43. SQL Optimizer for Oracle button in Toad’s Editor

Figure 44. SQL Optimizer for Oracle window
Tuning options
With your statement in the Optimize SQL window and SQL Details panel, you have several options:

- **Optimize**: Ideal for fast-running queries, this will automatically re-write the SQL and execute each unique execution plan. You will be notified as soon as a faster alternative has been identified.

- **Rewrite**: Ideal for long-running queries, this will only rewrite the SQL statement and allow you to evaluate each unique plan that has been identified. You can then decide which queries you want to test by executing them.

- **Index**: Ideal for product and application environments where the SQL statements are not available for rewrites. This will generate virtual indexes and allow you to see the new execution plans available before you physically create the index. If you test these scenarios, the indexes will be created and the original queries executed to verify the performance has improved.

- **Rewrite & Index**: Does both the Rewrite and Index scenarios described above.

Generate virtual indexes and see the new execution plans available before you physically create the index.
You can easily compare any two scenarios by seeing both the SQL syntax and execution plan differences side by side.

The Toad for Oracle Xpert SQL Optimizer includes an indexing feature that analyzes a collection of SQL statements to see which tables and views are being queried, and then examines the existing set of indexes.

Figure 47. As each scenario is executed, the scenarios are ranked by elapsed time. You can cancel execution at any time, or let it continue through all of the rewrites for a more exhaustive set of scenarios.

Figure 48. Comparing SQL alternatives in the SQL Optimizer
Impact analysis
Whenever you add one or more indexes to the database, the execution plans for your applications’ embedded SQL can be dramatically impacted. The Impact Analyzer allows you to model these proposed system changes so you can see exactly how your new index affects everything else in the database. We generate the new theoretical index and the new execution plans for each of your production SQL statements. And you can see what the before and after ramifications are to your system whenever you propose a change.

Toad tip: Identify key SQL code, propose a change to the system (a new index?), and then see how that change affects the execution plans for your SQL code.

Optimize current SQL
While in the Toad editor, you can now invoke a tuning session to run inside of Toad for the current SQL statement. This interface will automatically generate alternatives and execute them, alerting you to alternatives that generate faster execution times. This is ideal for tuning queries that run in minutes or seconds versus hours.

The Impact Analyzer allows you to model proposed system changes so you can see exactly how your new index affects everything else in the database.

Figure 49. Analyze Impact window in SQL Optimizer for Oracle
If you are looking for an interactive tuning environment where you have more control, you should continue to use the SQL Optimizer. However, if you are new to tuning SQL, then this feature is much simpler and is definitely worth a look.

When launching a tuning session inside of Toad, you’ll be asked to choose between an OLTP or data warehousing environment, specify a search depth that determines the number of re-write alternatives to investigate, and provide an optional time limit for the re-write and execution exercise.

Plan control
It is not always possible to implement a query re-write to solve a performance problem, especially in production. Oracle has introduced a new query performance management feature in 11g to address this, known as SQL Plan Baselines.

With a touch of a single button, in one test, Toad evaluated 60 different execution plans and identified a plan that took the response time from 43 seconds down to 6 seconds! That plan can be deployed to the database without making any changes to the application source or worrying about introducing any schema changes that could affect other parts of the application (like an index).
Optimize indexes (new for v11.0)
Use Optimize Indexes to analyze and improve indexes for a SQL workload or for any group of SQL statements. You can instruct SQL Optimizer to gather SQL from an application workload during a specified time period. SQL Optimizer evaluates your SQL workload and provides you with the best set of indexes to optimize database performance for that workload. After this evaluation process is complete, you can review the results and then select the new indexes you want to save and test.

You can instruct SQL Optimizer to gather a SQL workload from any of the following sources:
- Oracle® Automatic Workload Repository (AWR)
- Foglight™ Performance Analysis
- Oracle® System Global Area (SGA)
- Source code

After collecting the statements, SQL Optimizer provides you with the execution plans and run-time statistics. Select the statements for which you want to optimize indexes. After running

---

Figure S1. SQL Optimizer’s Optimize SQL Resolution report

Figure S2. Optimize Indexes shows execution plans and run-time statistics.
the evaluation process, review the results to determine the performance improvements. If, after reviewing the results, you choose to add new indexes, you can perform an Index Impact Analysis to determine how creating the indexes will affect database performance.

**DB admin module**

Database management made easy
Toad is not just for developers; database administrators also get features tailored to their needs. Any copy of Toad can be upgraded to include advanced database object management features with the DB Admin Module. Whether you need to create test environments based on existing instances, manage database resources, or compare and synchronize different instances, the DB Admin module is right up your alley.

**Health check (database > diagnose > health check)**

One of the most important features of the Toad DB Admin Module is the Health Check. Wouldn’t it be nice to give each of your instances a thorough checkup? With the Toad Health Check, you can.

Select the instances you want inspected, select the scenarios you want evaluated, and hit the “play” button. This feature can be scheduled, and you can have the results automatically emailed to you. It gives you visibility into each of your managed instances. For example, we can automatically identify ORA-600s in your Alert Logs or audit synonyms that point to non-existent objects.

**Toad tip:** Easily create multiple types of health check scans that run on selected instances on given days of the week and email the results to the DBAs responsible for those instances or database tasks.

The Database Health Check includes 16 checks for Oracle RAC environments and 11 new checks for production settings and virtualized environments.

**Database browser (database > monitor > database browser)**

Most users will rely on the Schema Browser for poking around the database, but for DBAs, Toad offers the Database Browser for more effective instance management. The Toad Database Browser allows you to connect to all of your databases and interact at the database level (users, roles, tablespaces, system privileges, etc.). You can select multiple instances and see the parameters set for each side by side, or drill down into the objects of the database, just like you can with the Schema Browser.
The Database Browser serves as your entry point for running most of the database level utilities in Toad. You can start a Health Check, look for the most expensive sessions, start up or shut down the instance, all with a single click.

Statspack browser (database > monitor > statspack browser)
Statspack allows you to see what was happening in your database for a specific period of time. For example, it can show you the tablespaces that were most frequently read and written to in the last 24 hours. And Toad gives you this information in just a few seconds. Additionally, you can use Toad to manage the Statspack statistics collection jobs and the associated snapshots.

Toad tip: Licensed for the Diagnostic Pack? Toad also offers an Automatic Workload Repository (AWR) browser and access to all of your ASH and ADDM reports.
Trace file browser (database > diagnose > trace file browser)

Are you tired of using TKprof to analyze your trace files and see what is causing your database performance degradation? Toad lets you visually inspect the contents of your Trace files. This allows you to immediately see all of the queries captured with their binds, waits, and performance profiles.

Even more help for DBAs: Toad™ DBA Suite for Oracle®

Ask your Account Manager how you can get the Toad™ DBA Suite for Oracle® to access our award-winning tools for:

- Real-time diagnostics — Toad DBA Suite for Oracle includes Spotlight® on Oracle® (supports Data Guard, RAC, and Exadata environments).
- Database activity record and replay — Toad DBA Suite for Oracle includes Benchmark Factory® for Oracle®.

With Toad for Oracle you can visually inspect the contents of your Trace files. This allows you to immediately see all of the queries captured with their binds, waits, and performance profiles.

Figure 56. Click on a query to see the binds variables and the values passed for execution.

Figure 57. Toad shows the number of queries that run for specific periods of time. Drill down to an individual statement to see the Execution vs. Parse vs. Fetch vs. Wait times so you know exactly how to approach a tuning scenario.
• Reverse-engineering of existing databases for rich ER diagrams or creating new physical or logical models from scratch – Toad Data Modeler is also included.

Additional tips
Ways to get data from Toad to Excel
You want to get data from Oracle to an Excel spreadsheet. You have Toad. There are two popular ways you can do this; each has its own advantages. Let’s take a few moments to explore your options.

Copy and paste
This is the most popular but least effective option, often used by newer Toad users. Select your data in the grid, Ctrl+A, Ctrl+C, ALT+TAB, Ctrl+V, and voila, your data is now in Excel.

What’s wrong with this method?
• You need to make sure Excel is open first.
• You won’t get any formatting (dates won’t come over as ‘date’).
• If you want to format the data in Excel after the fact, there’s no way to automate that without creating a macro.

Export dataset – Delimited text
This may be your fastest option. The only caveat is certain datatypes may not play nice. And of course it won’t be an XLS or XLSX file. This can take just about 25 seconds, not counting the time Excel took to load the file.
Oracle quick hit: You can bypass TNSNames
Ever spin up a database for some quick and dirty work, and you just want to connect without going through the whole 'add the service to your local TNSNames.ORA rigmarole'? The Oracle Net Configuration Assistant was one of the first Java-powered GUIs. It has been improved greatly over the past few years, but there are still much faster ways to connect to the database.

Yes, you can manage your TNSNames. ORA file manually using a text editor. But sometimes you know where the database is, and you just want to connect to it. Now.

EZCONNECT
When you just want to connect, you can put all of the connectivity information in your connection string—no need to interface with TNS. AskTom was talking about this waaaaay back in 2005, and Oracle has supported it since at least the 8i release.

Syntax
CONNECT username/password@[//]host[:port][/service_name]

Building your Where In () lists
Have you ever needed to write a query and filter your results with a WHERE EXISTS or a WHERE IN list of values? Your list will be comma delimited, and you’ll need to quote the strings appropriately. This is not so bad if you have a few values, but what if you have 42 or 420 or more? You are looking at the data in Toad, and you want to just wish it into a comma-delimited list (and maybe quoted), to feed into your: SELECT ...
FROM X
WHERE Y IN ('a', 'b', 'c', 'd', ...
'n');

Surely there is a way to have Toad build this list for you. Yes, there is—and you don’t even need to learn regular expressions (REGEX – wiki). As an aside, we recommend you learn REGEX; it is definitely worth the investment of your time.
There are so many little nuggets in Toad that you can take advantage of. To list all of them would be a daunting task. Custom Queries is one that you may have overlooked.

If you right-click on an object in the Schema Browser, you’ll see a list of operations you can perform. Take a second to look at the list for Tables: there are 36 operations available. The very last entry is “Custom Queries.”

So what is a custom query?

A custom query allows you to build dynamic SQL scripts using the selected list of objects as your WHERE clause.
written for you. The custom comes into play when you create your own or tweak the defaults to match your needs.

**Example**

If you need a quick inventory of constraints for a list of tables, you could select each table individually, go to the Constraints tab on the right side and create a report, but that would be several steps multiplied by the number of tables you need to audit. Instead, you can use a custom query to do this in just three steps:

1. Select your object(s)
2. Right-click | Custom Queries | Constraint Type Summary
3. Execute the query that is pasted into the editor

**Getting more help with Toad**

Toad for Oracle has more than a decade of feature development and investment behind it. It has features that can’t be adequately covered or discussed, even in this long document. For more help, please consult the following resources:

- Your sales representative. We are dedicated to keeping you and your company happy with its investment in the Toad solutions. Your sales rep can get your questions answered, provide insight into our solutions that will address your problems, provide evaluation copies of software, and help you manage your relationship with Dell Support.
- Visit the toad-for-oracle product page.
- Use www.toadworld.com, your free online resource for education, expertise, and collaboration.
- The Toad Idea Pond allows you to vote on and provide your recommendations on what you’d like to see in Toad.